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Welcome to the sixteenth edition of my Final Cut Pro newsletter! 

The goal of this newsletter is to provide information helpful to the 
professional user of Final Cut Pro. This newsletter publishes 
around the middle of each month. Past issues are not archived, 
however, key articles are posted to my website for your future 
reference. Unless otherwise noted, all references are to Final Cut 
Pro HD, and may not work under any other version.

Also, please invite your friends to visit my web site -- www.larryjordan.
biz. We are working to make this a great Final Cut resource!

Newsletter Contents

●     Discover the Secrets of Final Cut Pro 5 Seminar
●     Compatibility Report - Tiger, FCP and 3rd Party Capture 

Cards
●     Reader Questions on Final Cut Pro 5
●     Last month's survey on FCP 5
●     Editorial: Should you upgrade?
●     New FCP Utilities
●     Compressor Discussion Follow-up
●     Tips from the Classroom
●     Selecting which file format to use for web video
●     Reader mail

Discover the Secrets of Final Cut Pro 5 Seminar

My apologies for this issue arriving so late this month, there is a LOT of 
stuff going on around here at the moment. For most of this last month, 
I've been working on a new book for Lynda.com, this one on Final Cut 
Pro 5.

As I researched the book, I've discovered all kinds of hidden goodies 
inside FCP. So many that I created a new seminar series: Discovering 
the Secrets of Final Cut Pro 5, a Larry Jordan Master Class.

Final Cut 5 is out and now's the time to see what it can do -- and what 
the implications are for you when you upgrade.

I've been swamped with questions about whether to upgrade now or 
later, whether Tiger is ready for prime-time, and what the new features 

http://www.larryjordan.biz/
http://www.larryjordan.biz/


of FCP 5 are. Not just the big ones, like Multi-cam, but what are the 
small changes under the hood? How has capturing changed? How does it 
deal with HDV? What is Dynamic RT REALLY about? Can you really do 
multi-track mixes using the new Soundtrack Pro? And what's new in 
LiveType 2?

This eight-hour seminar is designed to give you the knowledge you need 
to tackle Final Cut 5 like a Pro, plus productivity secrets that will really 
make your editing system fly!

Our first Master Class is June 4, in Chicago.  
It's co-sponsored by the Chicago Final Cut Pro User Group.

Our second Master Class is June 25, in Los Angeles.  
 It's co-sponsored by the L.A. Final Cut Pro User Group.

We are finalizing dates for a July seminar on the East Coast. I'll have 
more details in that one in a couple of weeks.

Larry's Guarantee

For those of you who haven't heard me teach, I've decided to put my 
money where my mouth is. I'm so confident that you'll discover 
techniques in Final Cut that you never knew about that all my seminars 
are FULLY 100% guaranteed. 

If you are not satisfied, for any reason, let me know and I'll refund your 
registration fee. (And, if you want more reassurance, here are some 
comments from other students and readers.)

Registration is $195 and seats are still available. But hurry, both cities 
are filling fast.

[Go to top.]

TIGER and FCP Compatibility

On May 5, I got the following capture card compatibility report from 
Brian Summa, a long-time correspondent. Brian's report is courtesy of 
Brian Summa and Chesapeake Systems, Baltimore, MD (www.chesa.
com). Brian writes:

Here's the latest on Tiger compatibility:

●     OS reports that Qmaster (installed with Compressor) is a security 
problem; you either have to "Fix" "Disable" or "Decide Later"

●     Even without QuickTime Pro, FCP can export using both QuickTime 
Movie and QuickTime Conversion

●     You can create H.264 Compressor presets and droplets
●     Rendering in DV and 8-bit Uncompressed works (for those who 

remember Panther's QuickTime 6.4 debacle)

http://www.chifcpug.org/
http://www.lafcpug.org/
http://www.larryjordan.biz/training/testimonials.html
http://www.larryjordan.biz/training/testimonials.html
http://www.chesa.com/pro
http://www.chesa.com/pro


●     LiveType round-tripping still works

AJA (is recommending dual-boot systems):

Support for OSX 10.4 Tiger when FCP5 ships. We are now 
working with all the new features in FCP5 along with support 
for Tiger (we were showing FCP5 and the new Apps in our 
booth!), and will issue a channel update when we have fully 
tested the new OS software for our user base to move over 
to Tiger. If anyone is interested in running Tiger before the 
official AJA recommendation, we strongly recommend a dual 
boot system, of OSX 10.4 Tiger, and OS 10.3.x Panther for 
backup.

Blackmagic

The DeckLink Macintosh v5.0 drivers are fully compatible with 
both Mac OS X 10.4 and Final Cut Pro HD v5.0. The DeckLink 
Macintosh v5.0 drivers are scheduled for release when Final 
Cut Pro HD v5.0 has been released.

We officially recommend the use of Final Cut Pro HD v5.0 
with Tiger along with the new DeckLink Macintosh v5.0 
drivers. The DeckLink Macintosh v5.0 drivers are a free 
update for all DeckLink users. The latest drivers are always 
available from the Support page of our web site.

The DeckLink Macintosh v4.8 drivers have been tested and 
verified for use with Final Cut Pro HD v4.5 and Mac OS X 
10.3.8. While it is expected that both Final Cut Pro HD v4.5 
and the DeckLink 4.8 drivers will work with Tiger, this is an 
unsupported configuration and minimal testing has been 
conducted with this configuration. Furthermore we are 
unaware of any official support for Final Cut Pro HD v4.5 with 
Tiger. Accordingly we would recommend against attempting 
to perform critical work with Final Cut Pro HD and DeckLink 
cards until both Final Cut Pro HD v5.0 and DeckLink v5.0 
drivers have been released.

I don't expect any other third party drivers to work either. Don't even 
ask about SCSI! And as far as Astera goes...

AsteraTech (Yousef):

We know that Timba/Jumanji need to be revised for Tiger 
compatibility and do not work as they are. Apple's frequent 
OS changes are not making life easy as far as being able to 
support their releases. We are currently working on the next 
release of Timba for Panther. Tiger compatibility will probably 
follow that.

OVERALL RECOMMENDATIONS

Final Cut Pro HD (v4.5) and Tiger seems to work, but I would not sell it 
as anything other than a simple DV solution at this time because of the 
lack of third party support.



Larry, again. Brian sent me a second report, a couple days laters saying 
I may want to add the following notes in regards to Panther and the new 
PowerMac G5s. 

Brian writes: Believe it or not there still is a need to do so especially with 
installations involving Xsan.

We have successfully tested a new 2.7 GHz G5 with Mac OS 
X Panther (we were told by Apple the new machines would be 
Tiger ONLY and not boot Panther). However there are a few 
caveats and each should be discussed thoroughly with your 
clients before proceeding:

●     Installation from a Panther CD/DVD DOES NOT work 
when the new dual-layer DVD drive is used

●     Interestingly, installation from a Panther CD/DVD does 
work when a firewire optical drive is used or when the 
internal dual-layer DVD drive is replaced with an Apple 
Supported/Shipped optical drive 

●     Cloning Panther to a new 2.7 GHz G5 does work (ASR 
rules still apply)

●     Apple Systems Profiler reports the processors and RAM 
correctly

●     Apple Systems Profiler DOES NOT report the dual-layer 
DVD drive as "Apple Supported/Shipped" and therefore 
DVD burning/playback is not supported (this may be 
alleviated with 3rd party software like Patchburn and/or 
Roxio Toast Titanium)

BRIAN'S OVERALL RECOMMENDATIONS

Dual-boot systems are still recommended. Apple software licenses still 
apply, so those clients needing to run Mac OS 10.3.x on their new 
PowerMacs will need to purchase a boxed copy of Panther.

Larry, again, with an update: Earlier this week (May 27), updates were 
posted by AJA, Blackmagic Design and Apple -- all to support video 
editing on Tiger.

Also, I want to note that Cinewave is no longer supported by Pinnacle. 
So, please be very cautious trying to run Cinewave on Tiger.

Brian's comments, and the recent release of software updates from a 
variety of vendors simply illustrates a VERY IMPORTANT POINT: Simply 
because a new version of the operating system is released DOES NOT 
MEAN you should immediately upgrade to it. More on this in my 
editorial a bit later.

Updated (5/29/05)

Tom Wolsky comments: 

Much of this is not new or doesn't seem to be wholly 
accurate. Qmaster is hardly a security problem unless you're 
running wide open to the net. On any LAN it's perfectly 
secure. You've never needed QT Pro for full export 



functionality from any version of FCP. H.264 is now the 
default codec for QuickTime Conversion export, finally 
dropping the useless Video codec. Digital Cinema Desktop 
does work if the system is properly installed. It works on all 
the machines I've used and setup.

[Go to top.]

A Quick Technical Note on Installing FCP 5

I recently installed the shipping version of Final Cut Pro Studio and, after 
a long installation (there are up to 41 GB of data on I-don't-know-how-
many DVDs) I opened an FCP HD project into FCP 5 and my screens 
were varying shades of solid blue and green.

After restarting my heart and a quick check of the forums to see if 
anyone else had this problem, I went back to the Apple website and 
downloaded the latest version of QuickTime 7 and reinstalled it.

After the reinstallation, the FCP serial number automatically converted 
QuickTime to the Pro version -- no separate serial number or $30 (US) 
needed.

And, when I went back to FCP 5, all was well. My old project and clips 
opened fine.

Which brings me to one more point - please don't upgrade in the middle 
of a project unless the project is in such deep doo-doo that it can't get 
any worse. General wisdom, a very wise person, suggests that you only 
upgrade when a project is complete.

[Go to top.]

Reader Questions on Final Cut Pro 5

As you can imagine, the mail this month is full of questions about Final 
Cut Pro 5.

Turn Off Spotlight & Dashboard

Eric Stein writes:

When you mentioned [the inability to turn off Spotlight] at 
the recent LAFCPUG meeting, I remembered that there was a 
program to turn it off, but couldn't remember its name. I 
tracked it down.

It's called Spotless, and it's written by John "Printer Setup 
Repair" Goodchild.

http://www.fixamac.net/software/spot/

http://www.fixamacsoftware.com/software/spot/


Larry replies: Eric, thanks for this. I think Spotlight will become 
significantly useful in the future, but for now, I find it gets in the way of 
working with hard disks that need to move between systems. I view the 
inability to turn Spotlight off when necessary as a significant limitation to 
the software.

Correcting an Error in Last Month's Issue

When I was getting briefed by Apple at NAB, I thought I heard them say 
that the Browser in FCP 5 was dynamic, meaning that changes you made 
in the Browser would update the Finder and vice versa -- similar to how 
Motion works.

Markus Wernig wrote in to correct me:

I just talked to Brian Meaney at the L.A. presentation of Final 
Cut Pro today, and he said there is no Dynamic Browser in 
FCP 5. Bummer. Just wanted to let you know. It would have 
been very cool though.

Larry replies: Sigh... when I got Markus' note, I immediately removed 
the reference from my newsletter. However, in case you read the issue 
before I made the correction I wanted to let everyone know about the 
error. Sorry.

Improved Motion Effects

Dennis Csillag writes:

No one has covered the less-talked about features mentioned 
on the FCP 5 web page (except you did mention better sizing 
and rotation of stills).

"Final Cut Pro 5 features improved motion-tab effects and 
filters for superior image processing. With Compressor’s 
optical image flow analysis technology, you can achieve 
pristine format conversions. Plus, Final Cut Pro 5 also gives 
you improved support for 32-bit float image processing, new 
high-quality scale and rotate algorithms, improved HD 
Gamma Quality (701/609) and new Boris Vector Text 
Generators."

Maybe you could cover these.

Larry replies: There's a new set of adjustments on the Sequence > 
Settings > Video processing tab that allows you to improve the 
quality of effects created in the Motion tab. 



These include scaling, rotation and position, among others. What this 
setting does is control the quality of rendering of motion effects to 
remove aliasing and artifacts. In the brief time I've spent with it, does a 
markedly better job than FCP HD.

Multi-cam rendering

John Skaneby writes:

Thanks for your newsletter. I was at NAB and got FCP 5 
demoed. there seems to be a confusion  whether the multi-
cam work flow should result in a timeline that needed 
rendering. One apple guy could not give an answer, but on 
session with Apple personnel later they explained this to be 
correct and why then, when I checked the QuickTours out at 
apple.com, there were no render bar in that demo, isn't this 
strange?

Larry replies: As with all rendering in Final Cut, the speed of your 
computer will determine what needs rendering. I'm looking at a multi-
cam sequence running on a Powerbook. If I set quality to "High," it 
requires rendering. If I set quality and frame rate to "Dynamic," I get 
green bars.

Time of Day Timecode

Steve Lyons writes:

Could you expound on time-of-day timecode within FCP5. Eg, 
how it is used in multi-cam, if it is a column in the browser, 
can be identified on any clip in some way, if it can be used to 
distribute clips on a timeline so that they are spaced out to 



match the time of day recorded?

I think this may be a major new feature within FCP5 with lots 
of uses. Especially with multi-cam.

Larry replies: Steve, I'm not sure. I've been reading the manual, and it 
doesn't mention time-of-day timecode. Multi-clips allow you to sync clips 
based upon In, Out,Timecode, or one of two Auxilliary timecode tracks.

My suspicion on time-of-day support is that FCP uses it to delineate clips 
during capture, in terms of where one clip ends and the next begins. 
However, I'm not positive.

If anyone has better ideas, I'd like to hear them.

Updated (5/29/05)

Tom Wolsky wrote in to say that Time of day timecode is used to run 
multiple cameras in locked sync for use in multi-cam.

What OS Does FCP Support?

Brian Gray writes:

Could you please clarify whether FCP 5 will run on both 
10.3.9 and 10.4? For example is FCP 5 hamstrung in Panther 
only to be fully realized in Tiger? Not clear.

Larry replies: I asked Apple this exact question. They told me that FCP 
does not take particular advantage of any of the features in Tiger. In 
other words, functionally, it is the same app in both 10.3.9 and 10.4. 
Based on the work I'm doing here in researching my book, I haven't 
noticed any difference. 

The minimum OS is 10.3.9.

I have been told, as well, that FCP 5 does not take advantage of the 
graphics card the way Motion does. So, this means FCP will work just 
fine with current video cards.

Questions in Search of an Answer

Shawn Yashar writes:

We are now on FCP 4.5 and evaluating whether or not to do 
the 5 upgrade. If it were up to me, it would be done 
immediately, but since it is not, I need some ammunition in 
regards to bug fixes to things that were broken in the switch 
from 3 to 4, and some functionality that is in dire need of 
improvement.

I was wondering if you could illuminate for me if any of the 



following problems have been addressed in 5:

1.  Match-Frame should work "two steps back" not just 
one. Matching back from a subclip to master clip is not 
possible, without using remove Subclip limits which 
destroys the ins and outs of the subclip in the browser. 
Also, when matching back a clip, it reloads the clip from 
the Finder, not from the Browser. Therefore, the 
markers on the browser clip are not on the matched 
back clip. Freeze frames do not matchback.

2.  Motion effects do not reconnect properly when moving 
from system to system. It routinely adds unnecessary 
keyframes that force the editor to manually rebuild the 
motion effect by deleting the keyframes.

3.  Render Files do not reconnect at all. I don't know why 
this is even a function in FCP since I have never seen it 
work.

4.  Does the new RT engine support PhotoJPEG 75 or 
anything other offline full res (720x486) offline codec 
other than DV and Uncompressed? If not, has Offline RT 
evolved to a higher data rate and a larger image than 
quarter screen DV?

5.  Do Motion Effects still want to push all unlocked tracks 
down the timeline?

6.  Does having Duplicate frames enabled still slow down 
timeline editing to a crawl?

7.  Are there still ghost render files after a a opening up or 
closing of a gap in the timeline?

8.  Can you toggle between sequences from the keyboard 
now? Can you now toggle into the timeline of a 
sequence like you can in Avid? This would make it a lot 
easier to patch when cutting from sequence to 
sequence.

9.  Does FCP now differentiate between simple through 
edits and through edits that have a level shift or effect 
on them, as Avid does?

10.  Does FCP now have the ability to keep render files for a 
layer of video or audio that you have temporarily 
turned off?

11.  Does FCP still snap from viewer to canvas after every 
edit operation? This really a pain when you are making 
select sequences from long clips in the viewer.

12.  Have they added a keystroke combination for 
unpatching all tracks in patch panel?

13.  Can you now see that an effect has been applied to a 
clip from within the timeline, similar to the Avid 
timeline?

Larry replies: After reading your questions, based upon what I was told 
by Apple and what I've seen in working with FCP 5 the answer to most 
of your questions is no, there has been no change, with these 
exceptions:

1.  Rendering quality has been improved for motion tab settings, 
including scaling and rotation. This means that much of the 
excessive flickering should be decreased.

2.  Still images and video generators now have their own folder on 



 

your scratch disk which, Apple says, should improve playback 
reliability.

3.  The ghost render files problem should be gone.

 
4.  Clicking the Clip keyframes button indicates clips which have filters 

or effects applied. 

- A blue bar indicates a motion effect.
- A green bar indicates a filter is applied to the clip.
- And, the clip name indicates whether a speed change has been 
applied. 

However, these indicators are also true of FCP HD, so while not new with 
FCP 5, it is available. 

Updated (5/29/05)

Tom Wolsky adds:

●     Checking for duplicate frames has been greatly 
improved in FCP 5 and should no longer be an issue.

●     Regarding FCP snapping to the canvas, this depends on 
how the edit is executed. If you use the keyboard 
shortcut, the timeline (not the canvas) becomes the 
active window. If you use the edit overlay, the viewer 
remains the active window. If you use the keyboard 
shortcuts the Q key will return you to the viewer.

[Go to top.]

Last Month's FCP Survey

Last month, I asked you what your favorite features were with FCP 5. 
You can view all the results here.

Not surprisingly, Multi-cam took top honors, followed by:

●     Soundtrack Pro audio repair
●     Dynamic RT
●     Soundtrack Pro mixing
●     QuickTime 7
●     Improved scaling and rotation
●     Native HDV editing
●     and multiple audio channel support

We'll be looking at all of these over the next few months. Thanks for 
taking the time to vote, these results help me to focus on what to cover 
in up-coming newsletters.

 

http://www.larryjordan.biz/surveys.html


[Go to top.]

Editorial: Should You Upgrade to FCP 5?

The answer is Yes -- absolutely. But that's not the question. A better 
question is WHEN should you upgrade? 

In thinking about this, I've discovered this question has two parts:

1.  When should I upgrade to Tiger?
2.  When should I upgrade to Final Cut Pro 5?

Here's my current thinking:

●     I absolutely do not recommend Tiger 10.4.0
●     I think 10.4.1 is much better, but not yet ready for prime time

As the recent upgrades from Apple, AJA, and Blackmagic make clear -- 
we are still in a period of testing and shaking down this new operating 
system.

In brief, while I have great faith in the future of 10.4, I do not think it is 
stable enough in a professional environment to switch your editing 
system to the new OS quite yet.

Expecially because FCP 5 doesn't rely on Tiger to function.

Final Cut Pro 5, however, is a different matter. As FCP5 works on both 
10.3.9 and 10.4, I suggest a staged upgrade:

●     If you are shooting and outputting DV, you are probably OK 
upgrading to FCP 5 at any time.

●     If you are working in a professional environment and you can 
afford for your edit bay to be down from time to time, or you have 
a machine you can dedicate to testing, consider upgrading in the 
late-June to July time-frame as third-party software and hardware 
is updated.

●     If you are working in a professional environment with a lot of 3rd 
party hardware and software, AND you cannot afford to have your 
bay go down, then I do not recommend upgrading to FCP 5 till the 
fall at the earliest. There is just too much new stuff that needs to 
be debugged and tested.

Keep in mind that FCP 5 is still so new that we don't really know how 
stable it is. FCP 4.0, for example, was a disaster. FCP 4.5 was great.

Steve Martin, a fellow-Apple trainer who's opinions I respect, told me 
that he was impressed with the stability of FCP 5. Which helps reinforce 
my point - Final Cut Pro 5 may be perfect just as it is. However, it hasn't 
been in the market long enough for us to be sure.

For this reason, I urge caution. If you can afford down-time, upgrade 
sooner. See what happens and let me know. It may be great. If you 
can't afford down-time, then upgrade later. Let those who can afford it 



do the testing, then, once it's proven, you can make your move to the 
new platform.

As always, let me know what you learn and I'll share it with everyone 
else.

Updated (5/29/05)

Tom Wolsky adds:

Have to say I disagree about Tiger. I see nothing in it that 
would prevent doing the upgrade, and a lot of nice features I 
enjoy having. Most of the major third-party providers are 
already Tiger-compliant and for most other systems, DV, 
HDV, DVCAM, DVCPro25, DVCPro50, DVCPro HD, and even 
IMX, there is nothing in Tiger that doesn't make it viable with 
FCP.

[Go to top.]

New FCP Utility -- actually, here are TWO!

TitleExchange Pro

Andreas Kiel, from Spherico, recently developed a new FCP utility, 
which he wrote me about:

After I got many hundred downloads - thanks for your 
support - within the last days for TitleExchange Lite, I 
decided to publish a public beta of TitleExchange Pro 
(shareware 15.00 EUR).

The Pro (Beta) version does allow bidirectional conversion 
and includes "QTtext" as an additional format. You also can 
set alignment, font, style and size for STL and QTtext 
formats. For XML output the Pro version allows to save XML 
templates, which can be reused for easier handling.

The website shows a little bit more detailed information about 
how to use those features: http://www.spherico.com/
filmtools/TitleExchange

The current beta has some issues:

●     QT to QT cleaning is not implemented yet.
●     XML marker conversion is not implemented yet.
●     For some reason font settings are not exactly read on launch, so 

please open the "Preferences" and setup the values before you do 
the conversion.

●     " Illegal" source files may crash the application.
●     Still no icon for the application.

Andreas concludes, "I would be happy to get some feedback about the 
new version - no matter whether it's bad or good."

http://www.spherico.com/filmtools/TitleExchange
http://www.spherico.com/filmtools/TitleExchange


Foot Track

William Randall Myers sent me the following link for a video 
cataloging utility, called Foot Track.

http://www.foottrack.com/tour1.html

Larry writes: I have not used this, so I am simply passing this along for 
your reference.

[Go to top.]

More Discussion on FCP Exporting to Compressor

Following up on last month's article about the best way to export a 
sequence for Compressor, there was a batch of comments about 
Compressor. So, I decided to group them together to make the 
discussion easier to follow.

Gabe Unterman writes:

I find your newsletter extremely informative.  I have a 
question about newsletter #15, exporting Project files for 
DVD.

We are using FCP HD with DVD Studio Pro 3.  In your 
newsletter you suggest exporting the final project as a 
QuickTime movie and then compress the file in Compressor 
or DVD Studio Pro.  What I have been doing is exporting my 
final project from FCP as a MPEG 2 in the QuickTime 
Conversion menu.  If it is a large project I adjust the file size 
in the “Quality” menu of the MPEG 2 options.  Then import 
the MPEG 2 files into DVD Studio Pro and creating a DVD 
from the files exported from FCP.  Would you suggest I 
export the project as you say in the newsletter or continue 
with what I have been doing?  I am a little confused because 
I thought what I have been doing is the most efficient way to 
make a DVD from my FCP projects.

Larry replies: When Gabe first wrote, I sent him this reply:

"Your system works, but it isn't efficient. First, you are tying 
up FCP during the entire export and compression process, 
which can take a long time. Second, you don't have the same 
control over your compression as you do in Compressor. 
Third, depending upon your video format, you may be well 
advised to crop the image, which can't be done using FCP 
export.

For me, it's mainly a time and control issue. However, there's 
nothing intrinsically wrong with what you are doing."

http://www.foottrack.com/tour1.html
http://www.larryjordan.biz/articles/lj_dvd_export.html
http://www.larryjordan.biz/articles/lj_dvd_export.html


However, since then, I've learned more reasons why this isn't a good 
idea. In the version of Compressor that ships with FCP HD, your 
technique works fine. In the Compressor that ships with FCP 5, your 
technique will no longer work.

The new version of Compressor has technology in it that is not 
duplicated using QuickTime conversion. For this reason, you need to 
start changing your habits so that you follow the guidance in that article: 
export using File > Export > QuickTime movie.

If you are compressing the video on your system, make the movie a 
Reference movie. If you are archiving the movie, or sending it to 
someone else to compress, make it a self-contained movie.

I have never been comfortable with exporting using QuickTime 
Conversion. For one thing, it automatically down-samples your movie to 
8-bit. For another, it will not be as good a quality in the new version of 
FCP/Compressor. Finally, the codecs is contains, while adequate for 
home use, are not up to professional standards either in terms of file 
size or image quality.

Uli Plank, from Germany, writes:

Thank you for your current newsletter.

I'd like to add one word of caution to your short description 
of exporting projects from FCP to Compressor. From your 
wording unexperienced users might conclude that 
Compressor is good for getting your audio into A.Pack as well.

I can't recommend this, since I've frequently observed that 
AIFF files exported through Compressor and used in A.Pack 
get out of sync as opposed to those exported directly from 
FCP. I'm not sure if this happens in PAL only, but it is a long-
standing bug in Compressor well-known in our community 
over here. Until know it has never been fixed, even if I (and 
others) have informed Apple again and again.

In summary:

●     Export your video from FCP and encode it to MPEG-2 in 
Compressor 

●     Export your audio as WAVE or AIFF from FCP and 
encode it to AC-3 in A.Pack

●     Don't route audio through Compressor (which can't 
compress audio anyway).

Let's hope it'll be fixed in DVD SP 4 with it's tighter 
integration of AC-3 encoding (and hopefully the dual-CPU bug 
too), but for the time being one should advise FCP users to 
export audio always straight from FCP and NOT through 
Compressor.



Larry replies: Uli, this is not a problem I've noticed here in the U.S. 
using NTSC video. So, thank you for providing a warning and a 
workaround.

At a recent demo of DVD SP 4, I asked the DVD SP Product Manager, 
Brian Hoffman, if Apple had made any changes to the integration 
between DVD SP and FCP 5 so exporting to Compressor worked 
properly. He said that he didn't think so. My feeling is that if Brian 
doesn't think so, then probably nothing was done.

So my recommendation is to avoid using "File > Export > To 
Compressor" for any video format and, instead, do File > Export > 
QuickTime movie and bring that into Compressor. For audio, I 
recommend all PAL users follow Uli's advice.

Updated (5/29/05)

Tom Wolsky comments:

There is no more A.Pack in DSP, so this is moot. Dolby 
encoding is done inside Compressor. Whether this proves to 
be a sync issue in PAL, I don't know. 

Step Back for Better Quality

I just learned one other tidbit on using the Compressor shipped with FCP 
HD: using "Motion Estimation (Best)" may cause vertical jitter in your 
MPEG-2 movies. This problem can be avoided using "Motion Estimate 
(Better)". 

Compressor defaults to the "Better" setting, but if, like me, you changed 
the setting, you might consider setting it back -- at least if you are using 
DVD Studio Pro v3.

[Go to top.]

Tips from the Classroom

Teaching keeps you humble, well, it keeps me humble, at any rate. Here 
are the latest shortcuts discovered by my students:

Hoover: Typing "U" toggles between Ripple In, Ripple Out 
and Roll in Trim Edit window. (Larry's comment: It's always 
done this on the Timeline, I just never tried it in the Trim Edit 
window.)

Pat: To have Final Cut continuously loop playback over a 
section of your sequence, select View -> Loop Playback, 
set an In, set an Out and type Shift - \.

Kathy: Option - \ does the same thing as Option - p



Larry: Shift - T toggles Timeline track height.

Picking the Best Web Video Format

Philip Fass writes:

I have a suggestion for a story for the newsletter.

I know QT is available for PCs, but I can't find any data on 
how common it is. Is the idea of providing WMF files based 
on reaching a small proportion of the users, or is it really 
necessary for accommodating most of them?

Thanks.

Larry replies: The short answer is that religious wars are fought over this 
subject. Here are the latest stats that I've been able to track down:

October 27, 2004 - player market share

●     Windows Media Player: 38.2%
●     QuickTime: 36.8% 
●     Real Player: 24.9%

(Source: Frank Casanova, Senior Director, QuickTime Product Marketing)

As of May, 2003 (a lifetime in Net years)

●     Windows Media Player: 43.1 million
●     RealNetworks: 26 million
●     Apple QuickTime: 13.5 million

(Source: Nielson/NetRatings)

For my web work, I do everything in QuickTime. In spite of Microsoft's 
efforts at promoting Windows Media Player into the Hollywood 
production community, QuickTime still holds the dominant position.

For a general audience, you are generally safe providing your videos in 
two of the three formats, WMF, Real and QuickTime. For me, because 
Real works best with a streaming server, which I don't have, I tend to 
create three files each (slow, medium and fast connection) of both 
Windows Media and QuickTime.

Finally, with all the momentum behind the iPod, iTunes, and the iTunes 
Music store, QuickTime's installed base is growing dramatically. A fact 
that has significant implications for the future.

[Go to top.]

More Reader Mail



As you can probably tell, I love getting letters from readers. This is for 
several reasons -- I love learning new things, I like coming up with 
answers to your questions and, especially, I appreciate your pointing out 
when I'm wrong. Because I really want this newsletter to be as accurate 
as possible.

So, let's see what's come in this month!

Brian Gary writes:

I was reading your newsletter and would like to opine on one 
issue: Project Slow Downs

I've done several long-form projects (one doc had over a 
hundred hours of footage and thousands of stills) and I run 
into this issue frequently. For example, I was working on a 
doc and the project file had ballooned to over 50 megs and 
the speed hits that Renee described were fairly pronounced. 
When that happens I always look to see how many 
sequences are contained in the project (not just open in the 
timeline but contained, seemingly dormant, in the browser). 
Sure enough there were over 40 of them, various sections 
and drafts. So, what I tend to do then is Save-As, label that 
file as a sequence container then go back to the original file 
and remove all but the few sequences that I’m working on. I 
still have all the media, just trimmed out the sequences. In 
this particular case the file size dropped to around 30 megs 
and all the performance returned. If ever I need any of those 
sequences, they are kept in the container file. It appears that 
FCP uses resources to track all of the sequences, but doesn’t 
address more RAM. I’ve got 4 gigs of RAM and FCP (in the 
above example) never came close to exhausting the available 
RAM. Hmmm? As you wrote, could all be moot in 5.

Thank you for sharing and spreading the wealth of your 
knowledge... it is much appreciated.

Larry replies: Thanks for the kind words. Some of this has been 
addressed in FCP 5, in terms of opening and maintaining longer projects 
on the Timeline. However, slowdowns related to the Browser do not 
seem to have been addressed.

Here's another take on the Project Slow-Down issue.

- - -

Dilesh Korya, an editor for the BBC, writes:

The only way to resolve the problem would be to start a new 
project each time I start up FCP and copy all the bins and 
seq. over to this new project. (use either command-c then v 
or drag and drop) and use this project. from now on. And hey 
presto the problem is gone. The thing is, you have to 
remember to replace the old project. with the new one, with 
the same name, otherwise you will end up with lots and lots 
of folders containing your media as FCP starts a new capture 



folder for every new project. The first time I did this then by 
day five I had about 20 different folders with my media 
scattered throughout them. I had to spend another 2-3 hrs 
just getting everything together. You do not need the old 
project. once the files are transferred to the new one.

This new project has one little issue left- the clips in your 
sequence are not connected to your master clips in the bins- 
so 'f' or 'opt-f', etc does not work anymore (very annoying if 
you come from AVID). Highlight everything in your project, 
then go to 'Tools' and click on 'Create Master Clips'; just get 
through the next series of questions FCP asks and then wait 
as it re-links all the clips. If there are any clips in the 
timelines (such as titles, slugs, etc) that have no master clips 
in the browser, then a new folder will be created with 'Master 
Clips' written. You do not need to keep this folder, as the 
clips don't need a master link connection, so I delete it, but 
you don't have to. Up to you. Now the find master clip, etc 
should work.

This seems a really long way around of solving the 
sluggishness; but once you feel confident that it is working 
and you are not messing up, then you will speed through it; 
all done in 5 mins.

Larry replies: Apple made a big deal of how they improved the speed of 
opening a project on the Timeline, as well as decreasing the time it takes 
to display a project (the infamous "Preparing Video for Display"). So, 
this may be improved in FCP 5. However, in the event it isn't, these two 
workarounds can give you a hand.

- - -

File Size Rule-of-Thumb

John Grantham writes:

What a wonderful site you have. I stumbled upon it this 
morning and can tell it will be very helpful as I get up to 
spend with FCP. If you have time to answer a question about 
storage I would appreciate it. I'm going to edit a friend's 
movie which was shot on a Panasonic DVX100A in 24P 
advanced. I have 15, 60-minute DV tapes to go through as I 
log and capture. The final movie will be about 90 minutes. I 
am going to buy an external hard drive for this project. 

What is the rule of thumb regarding storage space? I'd hate 
to get 3/4 of the way through and run out of storage.

Larry replies: DV video takes 13 GB per hour to store. Generally, though 
you are shooting at 24 fps, you capture a DVX-100a at 29.97 -- so your 
file sizes are not reduced by shooting 24 frame material. So, to answer 
your question, I would allow 195 GB to store your raw footage, 20 GB 
for render files associated with your program, and about 20% for the 
hard disk -- so nothing smaller than 250 GB.

- - -



Kind Words for Graeme Nattress

Dave Meuhsam writes:

By the way... I had a good experience using Graeme 
Nattress' PAL conversion filter for that PAL DVD project a 
while back.  At least I haven't heard anything negative from 
client.

Larry replies: Graeme is a great guy and wizard programmer. I'm always 
pleased to pass on happy comments.

Here's the commercial that supports this newsletter.

I provide system design, consulting, editing, training and support 
for Apple's Final Cut Pro, DVD Studio Pro and Motion.

You can review my support and training services here.

If you need training, help or advice with Final Cut Pro, DVD Studio 
Pro, or Motion, I'd appreciate it if you would give me a call, (818) 
879-5105, or send me an email -- larry@larryjordan.biz -- 
worldwide.

My client list speaks for itself.

Your support of my services keeps this newsletter free.

Thanks.

Please  buy my book and DVD! Thanks.

Wrap-Up 

Well, that's it for this edition of the newsletter. Let me know what you 
think, and tell your friends to subscribe. I love reading your comments 
and sharing them with others. 

Or, send in some ideas of what you'd like us to talk about.

Even better, send in some tips of your own. I'm happy to publish 
everyone's ideas. That way, we all learn!

Thanks -- and have fun editing!

Larry

[ Go to top. ]
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your 
friends to sign up at www.larryjordan.biz.

To unsubscribe, simply send me an email and I'll drop you from the list. This 
list is not sold, rented, or bartered. The only person who knows you are on this 
list is me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please 
use your best judgment in applying these ideas.

The opinions expressed in these newsletters are solely those of the author. 
This newsletter has not been reviewed or sanctioned by Apple or any other 
third party. All trademarks are the property of their respective owners and are 
mentioned here for editorial purposes only.

Text copyright 2005 by Larry Jordan. All rights reserved. This newsletter may 
not be reproduced or published in any way, in whole or in part, without specific 
written (or emailed) permission from the author. 

Links to my website home page, or articles, are welcome and don't require 
prior permission. 
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